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Outline
What we are going to talk about today

« CARTA basics * Region of interest and
statistics

e Tutorials
o Spatial profile

 How to load images ,
* Spectral profile

 How to render images + Profile smoothing

* How to match images

» Spectral profile fitting

* Image analytics  mmmmmmmesmmemmmmm=em « Moment map generator
* Polarization cube visualization and analysis PV map generator
» Catalog visualization « Spectral line ID

 GUI customization * Rest frequency shifting
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I eSt I mages © cosmos_spitzer3.6micron_subimage fits
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© vla_20cm_lg_tan_10_subimage.fits
v 1 G31.41p0.31_bandscan

© G31.41p0.31_spw25.fits
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How to load images

Graphical user interface (GUI) v.s. commendline user interface (CLI)

File View Widgets Help e/ 00~ =B 4N H MOMKMNK S8 L QP O i | & ®
* Supported format: FITS, CASA, HDF5-
" J J Open image alt+ 0 Dfits X Profile: Cursor X
T T T ]
I D IA M I R IAD Append image  alt+L | 1:57:12.41); Image: (-77, 415); Polarization: Stokes I |- image = Active s  Region Active =
= o~
) Save image alt+S b 17:56:22.0 17:56:21.8 17:56:21.6 17:56:21.5 17:56:21.3 17:56:21.1 17:56:20.9 17:56:20.8 17:56:20.6
Close image alt+w —_ . 3.50e-1 Iql
1. < 3.00e-1 ,Vf Wy
Import regions A - || § 25081 \ 1
. G U I | &: - ;Jj .J’ 1
== el 2NN 1 “ \P_\ ny
o Y J
& File Browser 0 X ‘\’\r\ N ]
Import catalog alt+G J\ f‘rﬁ\f \I/Vw /
, "o
° (14 '| O . 39 e . C [ > uUsers > kswang > Desktop > carta_tutorial_v202302 > HD163296 e
— xport image »
File -> pen image ]
. . . . Preferences Filename Type Size 4= Date File Information Header te
(close existing images first) T T
Server ’ HD163296_C180_2_1fits FITS 60.6 MB 6 Feb 2023 R . R e
W P HDU =
c - HD163296_13C0_2_1.fits FITS 41.9 MB 6 Feb 2023 .
= : Data type = float
g T HD163296_CO_2_1fits FITS 56.8 MB 6 Feb 2023 Shape = [432, 432, 76, 1)
1 " . 5y s HD163296_CO_2_1.momd.fits FITS 846.7 kB 23 Oct 2012 Number of channels = 76 155720  -21:5718 2155715  -21:57-13
e “File -> Append imaae i fS  a467i8  230uzrz || Wember of polarizations = 1
= Coordinate type = Right Ascension, Declination
] ] ] ] ] © B Projection = SIN 5
without closing existing images " e |
| Image reference coords = [17:56:21.2813, -021.57.22.3607) |
o Image ref coords (deg) = [269.089 deg, -21.9562 deg) Iﬂ_\ f [N' | J‘l ‘J‘L
@ Pixel increment = -0.05", 0.05" Ll h Jj | ‘J\ HL J "r
u Pixel unit = Jy/beam { LV Ty Y f \J ]T" -
" " " . B Celestial frame = FK5, J2000 A J ' M |
¢ exiple Tiie Tl terlng Maodaes o[ Spectral frame = LSK
“L Velocity definition = RADIO 250 300 350 400
= Restoring beam = 0.678423" X 0.551015", 72.5103 deg te
r RA range = [17:56:20.509, 17:56:22.058)
% I NEC vranaea = .21 87 IR _1A1 =21 _87 11 _A111

Q Filter v HD163 Y Fuzzy search v

Close Load selected Load as hypercube

* Multi-selection (macOS: CMD+click, - .
Linux: CTRL+click) to load multiple
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How to load images

Graphical user interface (GUI) v.s. commendline user interface (CLI)

File View  Widgets

e Supported format: FITS, CASA, HDF5-

Help

HD163296_CO_2_1.momO.fits

IDIA, MIRIAD —

« GUI g
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Declination
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Render Configuration X

R
* Load a “computed” image via “lattice .
expression language” (LEL)

99%
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X Profile: Cursor X

1:57:30.82); Image: (21, 47); value: 7.0579e-2 JY/BEAM.KM/S ; Polarization: Stokes I I ! T ] Image Active - Region Active =
=l
n 17:56:22.0 17:56:21.8 17:56:21.6 17:56:21.5 17:56:21.3
] __ 1.40e-1
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o | € R }ﬁ\ )
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& File Browser QO X
O CJ > Users > kswang > Desktop > carta_tutorial_v202302 > HD163296
Filename Type Size ,= Date File Information Header

HD163296_CO_3_2.fits FITS 73.5 MB 6 Feb 2023

HD163296_C180_2_1.fits FITS 60.6 MB 6 Feb 2023 = LR Gl o b

HD163296_13C0_2_1.fits FITS 419 MB 6 Feb 2023 e

. Data type = float

HD163296_C0_2_1.fits FITS 56.8 MB 6 Feb 2023 Shape = [432, 432, 1, 1]

HD163296_CO_2_1.momi.fits FITS 846.7 kB 23 Oct 2012 Number of channels = 1

HD163296_CO_2_1.mom0.fits FITS 846.7 kB 23 Oct 2012 Number of polarizations = 1

Coordinate type =
SIN

Right Ascension, Declination
Projection =

Image reference pixels = [217, 217)

Image reference coords = [17:56:21.2813, -021.57.22.3607)
Image ref coords (deg) = [269.089 deg, -21.9562 deg)
Pixel increment = -0.05", 0.05"

Pixel unit = KM/S

Celestial frame = FK5, J2000

Spectral frame = LSRK

Velocity definition = RADIO
Restoring beam = 0.678423" X 0.551015",

[17:56:20.509, 17:56:22.058)
=21 87 R _1A1. 21 87 11 _A111

72.5103 deg
RA range =

NEC rancoe =

f# Image arithmetic ¥ "HD163296_CO_2_1.momo0.fits" * 1000 + "HD163296_CO_2_1.momf1.fits"

22.0
List filtering

Image arithmetic
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How to load images

Graphical user interface (GUI) v.s. commendline user interface (CLI)

« CLI

 macOS electron app: in .zshrc, set up an alias as
alias carta=‘’/Applications/CARTA.app/Contents/MacOS/CARTA’
Then in terminal
carta a.fits

e macOS homebrew installation:
carta a.fits

e Linux:
./carta.AppImage a.fits (may also set up an alias too)
carta a.fits (installation via a package manager like apt or dnf)

 URL query parameter (useful for workflow integration)
http://localhost:3002/?file=a.fits
http://localhost:3002/?files=[a.fits,b.fits]



http://localhost:3002/?file=a.fits
localhost:3002/?files=%5Ba.fits,b.fits%5D

How to render images

Raster image rendering

* By default, images are rendered

as raster

* Per-channel clip range as

default

* Use render configuration widget
to modify raster rendering

* Raster rendering:

e GPU-accelerated (WebGL2

 Tile-based, multi-resolution

File View Widgets Help e/ 00|~

HD163296_CO_2_1.momO.fits
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Image: (652, 27); Polarization: Stokes I
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Value (JY/BEAM.KM/S)

¥ T8 R QP [0 FE | R
T T T I T T
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20.5 17:56:20.0
100% Custom

Clip Min  0.0043526022471

Clip Max 2.179366466004%

Scaling Linear

Color map [ .

Invert color map

Bias / Contrast
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X Profile: Cursor X
Image  Active $ Region Active %
17:56:22.0 17:56:21.8 17:56:21.6 17:56:21.5 17:56:21.3 17:56:21 17:56:20.9 17:56:20.8 17:56:20.6
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0.000+0 et ———mmmm—m e e | e S | O
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X coordinate
Data: (WCS: 17:56:21.141, Image: 255 px, 7.55936e-1)
Y Profile: Cursor X
Image  Active s Region Active
-21:57:30 -21:57:28 -21:57:25 -21:57:23 -21:57:20 -21:57:18 -21:57:15 -21:57:13
~ 8.00e-1 P
< 7.00e-1 \
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< 5.00e-1 j L
@ 4.00e-1 / h .Y
>._, /’\/ \
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50 100 50 200 250 300 350 400
Y coordinate
Data: (WCS: -21:57:22.51, Image: 213 px, 7.55936e-1)
Image List X | Animator > Region List
Image Layers Matching Channel Polarization
0 HD163296_CO_2_ R xv](Rr] 0 Stokes |



How to render images

Raster image rendering

* By default, images are rendered
as raster

* Per-channel clip range as
default

* Use render configuration widget
to modify raster rendering

* Raster rendering:

 GPU-accelerated (WebGL2)

 Tile-based, multi-resolution

Layer O

Original image resolution 1 256 x 256
2048 x 2048 Downsample factor =8
Layer 2

. PR
¥ e v
Wi, R b" f
:"
b |
a . >

16 256 x 256
Downsample factor = 2

Layer 1

4 256 x 256
Downsample factor = 4

Layer 3

W ’ <
»
o
P s
‘
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~
gy >

64 256 x 256
No downsampling




How to render images

Contour image rendering

* Use contour configuration dialog for

contour rendering
* Flexible

e [ evel definition

* Smoothing scheme

o Styling

» Contour rendering:

File

HD163296_CO_2_1.momO.fits
T

Declination

16

22

24

28

32

View

Widgets

Render Configuration X

e GPU-accelerated (WebGL2

* Contour vertices are computed in
parallel

Cursor: 2.97 JY/BEAM.KM/S

Min

Help e/ 00~ =B

1:57:29.63); Image: (231, 71); Value:

1 1.5
Value (JY/BEAM.KM/S)

4.11093e-2 JY/BEAM.KM/S ; Polarization: Stokes I

22.0 21.5 17:56:21.0
Right ascension
99% 99.5% 99.9% 99.95% 99.99% 100% Custom
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Value (JY/BEAM.KM/S)

Data: (WCS: 17:56:21.227, Image: 231 px, 4.11093e-2)
Y Profile: Cursor X
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Data: (WCS: -21:57:29.61, Image: 71 px, 4.11093e-2)

Image List X | Animator Region List
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How to match images

Spatial matching

. . File View Widgets Help e/ 000~ =820+ H O kA S8 2 Qprv O F 2 | S
e Multiple images can be matched
Gaussian_SE.fits X Profile: Cursor X
AN ! | S I A ) ‘ L L [ T T 1T | | L N L G L L ! {8 L L L L I T T T T T T ] T leal .
. . . jl . Image = Active ¢ Region Active ¢
spatially so image panning and D e
S . S d
| | ] G o N
zooming are synchronized.
g 18 3
S >
=
8 o -
[ ] [ ] [ ] r;; o
e Use the image list widget to
S 0 100 200 300
o
n ] wi % 0 X coordinate
c & c o Data: (WCS: Image: 302 px, 0.0)
O S : i
e — Y Profile: Cursor
=S = .
gg 8%) <+ Image Active $ Region Active %
Qs o O g o
© - -48:32:42 -45:11:18 -41:50:57 -38:30:59
| | | |
 Matched images share their | s |
8 || E 200e-5
= ~ S 2 )
5:; o g ﬁ, 1.50e-5
= g )
9 i 2 1.00e-5 |
o|l S
" i ~  5.00e-6 J{ n
e contour / vector field / Catalog ! =S
© S = 100 200 300
[ ] = 3 o
<] 4 . Y coordinate
8
rel lderl I lg r?? 7 Data: (WCS: Image: 133 px, 0.0)
i Image List X | Animator Region List
!!\l!!!‘llll‘llllllllllllllIllllllllllllllllllllll ') \ A A A \ A A A l L 'l 4 / v L L /
50:00 40:00 30:00 20:00 10:0011:00:0050:00 30:00 20:0010:10:00 12:00:00 11:00:00 10:00:00 9:00:00 8:00:00 Image Layers Matching Channel Polarization
Right ascension Right ascension 0 Gaussian_SE fits . (R 0 Stokes |
. re iO'l Set Render Configuration Gaussian.fits XY R 0 Stokes |
0, 0, 0, 0, 0, 0, 0,
g 90% 95% 99% 99.5% 99.9% 99.99% 100% Custom Clip Min  0.0000019866907
Clip Max 0.680105468750(
. Scaling Linear <
M,
e Reference image v.s. secondar iy :
. . : Ujhﬂmhj‘l;ﬂ“\f Colormap D =
ic
EE

images

qm" i A | Ll‘ b L { ' | ® .
. W imd Wil ‘ﬂJ,J[f WL 1LY TSR PR O ), YT A T

Cursor:

0.1 0.2 0.3 0.4 0.5

Value (Jy/beam)
0.86 Jy/beam

Invert color map

0.8 0.9
Bias / Contrast ¥




How to match images

Spatial matching and spectral matching

File View  Widgets Help

* Multiple image cubes can be matched ...
spatially and spectrally so image fFor s

9.00e-

panning and zooming are =

I
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%
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7]
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L
2
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Ap

6.00e-
5.00e-

synchronized and channel switching is = Fi Browser o -
aISO SynCh ro n ized C [ > Users > kswang > Desktop > carta_tutorial_v202302 > HD163296

alue

0.6 0.7 0.8 0.9
Filename Type Size 4= Date File Information Header te
HD163296_CO_3_2 fits FITS 73.5 MB 6 Feb 2023
. . . HD163296_C180_2_1fits FITS 60.6 MB 6 Feb 2023 Name = HD163296_CO_2_1.fits
HDU = (0
* Use the image list widget to perform s
- Data type = float
HD163296_CO_2_1.fits FITS 56.8 MB 6 Feb 2023 Shape = [432, 432, 76, 1]

HD163296_CO_2_1.mom1.fits FITS 846.7 kB 23 Oct 2012 Number of channels = 76

" "
II I Iage I I Iat‘ I III Ig HD163296_CO_2_1.momO0.fits FITS 846.7 kB 23 Oct 2012 Number of polarizations = 1

Coordinate type = Right Ascension, Declination
Projection = SIN

Image reference pixels = [217, 217)

Image reference coords = [17:56:21.2813, -021.57.22.3607)
Image ref coords (deg) = [269.089 deg, -21.9562 deg]

* Spectral matching adopts nearest e s

Celestial frame = FK5, J2000

" 2 Spectral frame = LSRK
I I I er O a IOI l Velocity definition = RADIO 0.6 0.7 0.8 09
Restoring beam = 0.678423" X 0.551015", 72.5103 deg

RA range = [17:56:20.509, 17:56:22.058)
NRC vranaa = (=21 87 R _1A1. =21 87 11 _A111

Q Filter ~ Y Fuzzy search v

. Beference Image v.s. secondary
images ,_ —

* Use the animator widget for channel
navigation _



Try to load images in CARTA

* Use any of the test images

v 1 cosmos_field

cosmos_0_simbad.xml
© cosmos_herschel250micron_subimage.fits
© cosmos_spitzer3.6micron_subimage fits

© vla_20cm_lg_tan_10_subimage.fits

v ] G31.41p0.31_bandscan

© G31.41p0.31_spw25.fits

—

O G31.41p0.31_spw27.fits

v Gaussian_array

© Gaussian_SE fits
O Gaussian.fits

—

Try to change the appearance of your raster images - o 13296

* Use any of the test images

Try to configure and render contours

* Use any of the test images

Try to match your raster and contour images
 Use images in Gaussian array

 Use imagesin HD163296 folder

HD163296_13C0_2_1.fits
HD163296_C180_2_1.fits
HD163296_CO0O_2_1.fits
HD163296_CO0O_2_1.mom0O.fits
HD163296_CO0O_2_1.mom1.fits
HD163296_COQO_3_2.fits

o loF [of o} o o

" HL_Tau_pol

HL_tau_band3_Stokes_|.fits
HL_tau_band3_Stokes_Q.fits
HL_tau_band3_Stokes_U.fits
HL_Tau_band6_Stokes_IQUV.fits
HL_Tau_band6.POLA. fits
HL_Tau_band6.POLI.fits
HLTau_band7_cont.fits

fo? [o? [0} o [0 [} [o

v 1 IRCp10216_line_pol

O |RCp10216.cube.lQUV. fits

=

v B S255

© S255_CH3CN_subcube.fits



Image analytics

Region of interest and statistics

Region of interest can be created via
* the region bar at the top of the GUI

* the tool bar in the image viewer

Region of interest can be exported as a text

file in CASA (.crtf) or ds9 (. regqg) format

The region list widget summarize all region
properties

The statistics widget reports region
statistics

“Active” image and “active” region

Flexible image, region, and polarization
configuration

HD163296_13C0O_2_1.fits

File View Widgets Help B/ 00~ =B A& A& H b

15

A L L L L L LB B BLBLR B

0.45

0.38

0.24 0.31
Declination

0.17

0.10

0.03

-]
N
c b
9O =
© o
£
©
()
(@)
un
o
&
wn
™
; 1 1 1 1 1 1 1
219 21.7 1756:215 213
Right ascension
Image List X
Image Layers
0 HD163296_CO_2_1.fits R

1 HD163296_13C0_2_1.fits R

10
T

Create region
Double-click to select region type.
Press C to enter creation mode.

35

(N Ol¥ @

N wes HE e B »

1 1 1 1 1 1 1

0.21

0.17

0.13

0.09

0.05

0.01

219 21.7 17:56:21.5 213

Right ascension

Channel Polarization
xv)(zZJ(r] 43 Stokes |
R 22 Stokes |

& 2ewn @BFO 7

Statistics: Region 1 X

Image 0:HD163z ¢ Region Region 1

Statistic Value

NumPixels 7.776000000000e+3 pixel(s)
Sum 3.884960652800e+1 Jy/beam
FluxDensity 2.292968145568e-1Jy

Mean 4.996091374486e-3 Jy/beam
StdDev 1.247639962740e-2 Jy/beam
Min -2.712633647025e-2 Jy/beam
Max 3.914005681872e-2 Jy/beam
Extrema 3.914005681872e-2 Jy/beam
RMS 1.343880421058e-2 Jy/beam
SumSq 1.404356942154e+0 (Jy/beam)”2

Statistics: Region 2 X

Image 0:HD163z ¢ Region Region 2

Statistic Value
NumPixels 1.086800000000e+4 pixel(s)
Sum 1.900031796137e+3 Jy/beam
FluxDensity 1.121430246910e+1 Jy
Mean 1.748281004910e-1 Jy/beam
StdDev 1.559848179366e-1 Jy/beam
Min -5.150639265776e-2 Jy/beam
Max 5.175561308861e-1 Jy/beam
Extrema 5.175561308861e-1 Jy/beam
RMS 2.342944501037e-1 Jy/beam
SumSq 5.965867894493e+2 (Jy/beam)”2
Animator X
K (] [= M
Image
0
© Channel
0 13 s

FrameRate ¢ 5

HD163296_13C0O_2_1.fits

LSRK

55 220.3955 cuz

4.3335 km/s

£|>

Statistics: Region 2 X

Image 0:HD163z ¢ Region Region2 %

Statistic Value

NumPixels 1.086800000000e+4 pixel(s)
Sum 1.900031796137e+3 Jy/beam
FluxDensity 1.121430246910e+1 Jy

Mean 1.748281004910e-1 Jy/beam
StdDev 1.559848179366e-1 Jy/beam
Min -5.150639265776e-2 Jy/beam
Max 5.175561308861e-1 Jy/beam
Extrema 5.175561308861e-1 Jy/beam
RMS 2.342944501037e-1 Jy/beam
SumSq 5.965867894493e+2 (Jy/beam)"2

Statistics: Region 2 X

Image | 1: HD163z ¢ | Region Region2 %

Statistic Value
NumPixels 1.086800000000e+4 pixel(s)
Sum 8.479241844869e+2 Jy/beam
FluxDensity 4,535728594957e+0 Jy
Mean 7.802025989022e-2 Jy/beam
StdDev 7.350037044537e-2 Jy/beam
Min -2.410069666803e-2 Jy/beam
Max 2.671321332455e-1 Jy/beam
Extrema 2.671321332455e-1 Jy/beam
RMS 1.071866051583e-1 Jy/beam
SumSq 1.248621077599¢e+2 (Jy/beam)”2
Region List X

2 Name Type

Cursor Point
% #> Region1 Rectangle

b % /> Region?2 Ellipse

Center

17:56:21.569
-21:57:37.07

17:56:21.5707857614

-21:57:17.0579592663

17:56:21.3975066373
-21:57:23.9526154175

P.A. (deg)

0.0

©

0

o

0

9

4



Image analytics
Spatial profile

* The spatial profile widget displays
a spatial profile from

* Cursor and point region (treated
as a horizontal or a vertical cut

* Line region
* Polyline region

* The averaging width is configurable
in the settings dialog

* Projection distortion is considered
when the offset or distance is
calculated

File  View

HLTau_band7_cont.fits
WCS: (4:31:38.4268,

57.8 58.0 58.2

57.6

<

~

(o]
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S«
=N~
s
S o
()] 4
Qb

G2

©

@

©

Vo]

©

©

To]

<

©

To]

AN

©

o]

38.48

Region List X

Q@ Name

Cursor

i‘ :-: 4‘ Region 1
i‘ :-: 4 Region 2
i‘ :-: @* Region 3

Widgets

Help

38.46

s /000~ =B« 4B 4o Eas

18:13:56.748); Image:

38.44

(1022, 939); Value:

38.42 4:31:38.40
Right ascension

1.02104e-3 JY/BEAM ; Polarization: Stokes I

Spatial Profile Settings: Region #1

Styling

Width

38.38

Type

Point

Line

Polyline

Point

Smoothing

38.36 38.34

Center

4:31:38.4268
18:13:56.748
4:31:38.4253713263
18:13:57.2464406812
4:31:38.4143241805
18:13:57.6211731544

4:31:38.4071698565
18:13:57.0455840037

Computation

38.32 38.30

Size

2.1428555445"

1.2381161681"
0.7314778330"

Q0 - A A °

X Profile: Region #3 X Y Profile: Region #3 X

« Image | 0:HLTau_I $ | Region Region3 $ Image | 0:HLTau_| ¢ | Region Region3
[aV]
. O
P 4:31:38.48 4:31:38.43 4:31:38.38 4:31:38.33 4:31:38.28 18:13:56.28:13:56.68:13:56.98:13:57.38:13:57.68:13:58.0
1.60e-3
< 1.50e-3 s 1'388'2
ol & S 1000
.Ule-
2 m i)
E E 1.00e-3 E 8.00e-4
Sl o 6.00e-4
s i0e= § 4.00e-4
2.00e-4
0.00e+0 0.00e+0
wn
é 800 1000 1200 1400 1600 800 900 1000 1100 1200 1300
S] X coordinate Y coordinate
Data: (WCS: 4:31:38.4072, Image: 1102 px, 7.83578e-4) Data: (WCS: 18:13:57.046, Image: 1024 px, 7.83578e-4)
Profile: Region #1 X
S Image | 0:HLTau_| ¢ | Region Region1 %
oS
1.00e-2
22(‘ 8.00e-3
S w
S| L 6.00e-3
=
@ =
8 4.00e-3
©
~  2.00e-3
Q 0.00e+0
o
S
o -1 -0.5 0 0.5 1
Offset (arcsec)
Profile: Region #2 X
Image | 0:HLTau_| ¢ | Region Region2 &
7.00e-3
P.A. (deg) ___ 6.00e-3
3 5.00e-3
0.0 %
D 4.00e-3
>
312.6 ‘&)’ 3.00e-3
3
S 2.00e-3
0.0 1.00e-3
0.00e+0
0.0
0 0.2 0.4 0.6 0.8 1 1.2 1.4 1.6

Distance (arcsec)



Image analytics
Spectral profile

* The spectral profiler widget
displays spectral profiles

from different images
from different regions
with different statistics

from different polarization
components

* Channel navigation can also be
performed with the profiler plot

File View Widgets Help B/ 000~ =B H UDOFH AKX S8 2 QP 0 - 2 Q
HD163296_13C0O_2_1.fits
o — o —
i) M WCS: (17:56:20.559, =-21:57:30.53); Image: (417, 53); Value:
43 1.96653e-3 Jy/beam ; Frequency (LSRK): 220.3945 GHz;
< <
= il Velocity: 5.6618 km/s; Polarization: Stokes I
= =
-
: j3| - )
o o
& X
~ "4
w0 0
c o c N
=) % o
R 28 S
© © i
(0] ()]
0% S
w0 w0
o o
o o
o
& & =
] 5]
o
& & o
I
22.0 21.8 216 21.4 212 17:56:21.0 20.8 20.6 22.0 21.8 216 21.4 212 17:56:21.0 20.8 20.6 i
Right ascension Right ascension
Render Configuration X
0, 0, 0, 0, 0, 0, 0, 0,
90% 95% 99% 99.5% 99.9% 99.95% 99.99% 100% Custom Histogram = Per-Channel &
/ | \L Clip Min  -0.021816094215
/ : \ Clip Max 0.179616233302:
/ : \ Scaling Linear <
{ : \ Colormap D $
K i X ]\IL Invert color map
i WHUHHILM%M Bias / Contrast ¥
i T A
: : A !WLML HFJTL"WI ‘lihﬁ ﬂhﬁwg.‘ i[,
c |
= _ =
0 0.05 0.1 0.15 0.2

Cursor: 0.18 Jy/beam

Value (Jy/beam)

Region List X
Q' Name Type Center Size P.A. (deg)
. 17:56:20.559
Cursor Point -21:57:30.53 0.0
Animator X
K First M Prev » Play M Next A Last - Mode FrameRate $ 5 :
[mage HD163296_13C0O_2_1.flts
0 @
© Channel -
0 13 m 39 55 220.3945 cHz
5.6618 km/s
Image List X
Image Layers Matching Channel Polarization
0 HD163296_CO_2_1fits R xvJ(ZJ(r) 38 Stokes |
1 HD163296_13CO_2_1.fits R XY Z R 26 Stokes |



Image analytics
Spectral profile

* The spectral profiler widget
displays spectral profiles

from different images
from different regions
with different statistics

from different polarization
components

* Channel navigation can also be
performed with the profiler plot

File View Widgets Help e/ 100 ~ =

HD163296_CO_2_1.fits

WCS: (17:56:20.843, -21:57:28.20); Image: (338, 99); value: - @4\ Name Type Center Size P.A. (deg)
=l 8.26568e-4 Jy/beam ; Frequency (LSRK): 230.5336 GHz; o © ‘BG:
- - Cursor Point 7 E,’G ,20‘843 0.0
Velocity: 5.7696 km/s; Polariz@tion: Stokes I -21:57:28.20
——— ) e—
© © ECAF S . . 17:56:21.3940402918 2.2178571429"
. - N = ‘> Region Ellipse -21:57:20.8427941389  2.3142857143" 0.0
o o y—
T T o LCAF 8 . . 17:56:21.1653073244 2.2660714286"
B % = > Region2 Elpse -21:57:24.2177939945 2.1696428571" "0
c o c o = -
S 0 8 A Reai 17:56:21.2831398366  11.3785714286
T o MR-RY ol 3% AN Region3 Rectangle  1:57:22.6508322548 10.5107142857" 00
£ ol .E
© ©
[ (]
[al: 03 0
=
o
o w
o o
o o]
o o
=] -
) o ) Animator X
3 & ]
Right ascension Right ascension
]mage HD163296_CO_2_1.fits
Render Configuration Z Profile X m )
Image O:HD1.. ~ Region Region ... ~ Statistic Mean ~ Polarization A M © Channel
LSRK
0 18 m 54 75 230.5336 GHz
P 5.7696 km/s
E  1.00e-1
8
3 5.00e-2 0]
=
i'J
= 0.00e+0 =
-5 0 5 10 15
[LSRK] Radio velocity (km/s)
. Data: (5.770 km/s, 9.73e-2), HD163296 CO 2 1.fits, Region 1, Statistic Mean, Cocoridnate Current -
. Data: (5.770 km/s, 1.18e-1), HD163296 CO 2 1.fits, Region 2, Statistic Mean, Cooridnate Current Image List X
- Image Layers Matching Channel Polarization
Z Profile X
0 HD163296_CO_2_1.fits R (xv)(z)(r] 38 Stokes |
Image O0:HD1.. ~ Region Region... ~ Statistic Mean,S... ~ Polarization A M HD163296_13C0_2_1fits R XY Z R 26 Stokes |
= 1.00e-1 el )
R e
= 5.00e-2 _I_] =
® e J_I_r"_J L‘ﬁ_L -
s e . g o
= 0.00e+0 ————— —— — —— ——— T
5 0 5 10 15

[LSRK] Radio velocity (km/s)

. Data: (5.770 km/s, 2.71e-2), HD163296 CO 2 1.fits, Region 3, Statistic Mean, Cooridnate Current
. Data: (5.770 km/s, 7.55e-2), HD163296 CO 2 1.fits, Region 3, Statistic StdDev, Cooridnate Current

F’V

a -

Region List X




Image analytics

Profile smoothing

F - . File View Widgets Help B/ 000~ =B &N hbDOHA&<X¥ S8 AL Q@ O - 2 Q
U I T T T l T T T I T T T I T T T I T T T l T T T I T T T | ] T | T T T T T T T | T T T | T T T l T T T | T T | T ' T 1 . ) 2
Z Profile Settings: Regio| None P.A. (deg)
n n n 1.68639e-3 Jy/beam ; Frequency (LSRK): 219.5562 GHz;
Velocity: 5.6957 km/s; Polarization: Stokes I . S ol
| B Conversion Gaussian ents
=A™ ‘ 0.0
0 | 0 Hanning
o
. Method v Binning
Savitzky-Golay
- Line Style Decimation
8 g 3
r~ = s . .
t / N A = i Point Size (px)
C C o
e -9 | .9 |
© ©
I l : ; e = Overlay [ @)
3 3 2
o o |0 P
o 2| o Binning Width 3 2
Al
] [ | Rate s 5 :
¢ Va” OusS Sn |00t| 11N - y
3 ° ]
562 GHz
J o o
) I I I I N NS T SR S IR (T I (U TR R | P @
22.0 21.8 21.6 214 212 17:56:21.0 208 20.6 L 22.0 21.8 21.6 214 212 17:56:21.0 208 20.6
Right ascension Right ascension
Render Configuration Z Profile X 0
Image Active.. ~ Region Active ~ Statistic Mean ~ Polarization A M
‘ Image List X
1.50e-2 ] Image Layers Matching Channel Polarization
E | {— 0 HD163296_13C0O_2_1.fits R xv)(zJ(Rr) 26 Stokes |
2 100e2 1 HD163296_C180_2_1fits R XY (Z R 40 Stokes |
5 ]
E
gj
- 5.00e-3 ‘_‘:7—‘:%
0.00e+0 - et _— p— :ﬁ——\;mi —_— — — .
-5 0 5 10 15
[LSRK] Radio velocity (km/s)
. Data: (5.662 km/s, 9.28e-3), HD163296 13C0 2 1.fits, Region 1, Statistic Mean, Cooridnate Current

- Data:

(5.696 km/s, 3.23e-3), HD163296 C180 2 1.fits, Region 1, Statistic Mean, Cooridnate Current



Image analytics
Spectral profile fitting

* Multiple Gaussian or Lorentzian e —r S
profiles are supported with an 3 e L L - S o
optional Oth or 1st order continuum. Y EEET B e s

* Flexible initial guess configuration :

 Smart guess! 1| |~ v e

B il o

* Profile data in the view are the input o
data for the smart guess and fitting

» If profile smoothing has been i
applied, smoothed profile is the e
input data for fitting



Image analytics
Image fitting

File

View  Widgets Help e/ 00~ |

HD163296_CO_2_1.momO.fits

* Multiple-Gaussian
components can be fitted

* Optionally, fitting
parameters can be locked

WCS: (17:56:20.707, =-21:57:22.03); Image: (376, 223); Value:

 Model and residual images
are generated and |
appended after fitting

* Elliptical regions can be

<t
il 1.19511e-1 JY/BEAM.KM/S*; Polarization: Stokes I o
o
o
Data
© _.-.--""' : ©
o s =,
(\! -
> 3
. b
& :
S . o o
T & § H -
= s 5
© A
® i
[ =
N i
: ©
: o
©
o [}
«©
o -
1o
o
™
21.8 21.6 21.4 21.2 17:56:21.0 20.8
Right Ascension
<
o
o
Residual
© ©
o
N
P s
o -
&
S : o o
© & g -
£ s H
© i
o H
o < H
& i
H @
H K=
o ".
N -'
@
N <
| o

created based on the
fitting results

30

20.8

214 21.2 17:56:21.0

Right Ascension

21.6

B & & H

Declination

28 26 24 22 -21:57:20 18 16 14

30

@ PV

21.8 21.6 214 21.2 17:56:21.0
Right Ascension
Image List
Image Layers

0 HD163296_CO_2_1.mom0O.fits
1 HD163296_CO_2_1.mom0_model.fits
2 HD163296_CO_2_1.mom0_residual.fits

2 S A
F3¥ i O
- : ¢ Image Fitting
=)
7 Data source
Region
©
Components
Coordinate
oo
Center (px)
J @
= Amplitude (JY/BEA...
o<
5 Fitting Result

Full Log

20.8

O 2 X Center X = 17:56:21.2820182198 * 0.0016
. Center Y = -21:57:22.4240304387 * 0.001
MatChlng Avnse 1 5 hvvad - 1 2129121 + n nnannn t T /oA
(xyJ(Rr]
XY R Data: (WCS: -21:57:17.81, Image: 307 px, 1.1951le-1)
Y = . .
X Animator X || Region List X
" © Name Type Center Size
. 17:56:20.707
Cursor Point -21:57:22.03
LAy 8 Fitting result: Ellipse 17:56:21.2731404293 6.2160888443"
x T Component #1 -21:57:22.6709530449 4.4918787523"
‘\ LAy 8 Fitting result: Ellipse 17:56:21.2820182198 1.5046398973"
A= ™ component #2 -21:57:22.4240304387 1.0225456848"
‘\ :.: 4\ Annotation 7 Text - Ann 17:56:21.6982427263 3.0453100681"

o
Active =
Image -
2 = i
v lil 2
© Image World  Auto %
216 s 216 Y
WCS: (17:56:21.2813428320, -21:57:22.3606536840)
1 ™Y

17:56:20.6

400

@ Model @D Residual m MO D

Component #1:

Center X = 17:56:21.2731404293 * 0.0025
Center Y = -21:57:22.6709530449 * 0.002
Amplitude = 0.915817 * 0.000489 (JY/BEAM
FWHM Major Axis = 6.216089 * 0.004071 (arcsec)
FWHM Minor Axis = 4.491879 * 0.002955 (arcsec)
P.A. = 135.176592 * 0.080102 (degq)

Component #2:

-21:57:16.3106208094 1.3991965178"

P.A. (deg)

0.0

135.2

130.0

0.0



v 1 cosmos._field
cosmos_0_simbad.xml
© cosmos_herschel250micron_subimage.fits
© cosmos_spitzer3.6micron_subimage fits
O vla_20cm_lg_tan_10_subimage.fits
v = G31.41p0.31_bandscan
© G31.41p0.31_spw25.fits
© G31.41p0.31_spw27.fits

v | Gaussian_array

Try to visualize a spatial profile from a line or a polyline region

* Use any of the test images 5 Gaussian SE fits
Z Gaussian.fits
Try to visualize spectral profiles from multiple matched images v 7 HD163296
© HD163296_13C0_2_1fits
» Use images in HD163296 folder & HD163296_C180_2_1fits

HD163296_CO_2_1.fits
HD163296_C0O_2_1.mom0O.fits
HD163296_C0O_2_1.mom1.fits
. . & HD163296_CO_3_2 fit

» Use images in HD163296 folder or S255 folder — e

v HL_Tau_pol
© HL_tau_band3_Stokes_|.fits

Try to visualize spectral profiles from different regions of an image L.

Try to smooth a spatial or a spectral profile 3 HL_tau_band3_Stokes_Q fits
© HL_tau_band3_Stokes_U.fits
« Use images in HD163296 folder or S255 folder % HL_Tau_band6_Stokes_IQUV.fits
© HL_Tau_band6.POLA fits
Try to fit Gaussians to a spectral profile & HL_Tau_band6.POLIfits

© HLTau_band7_cont.fits
v " IRCp10216_line_pol

© IRCp10216.cube.lQUV.fits
v B S255

O S255_CH3CN_subcube.fits

« Use images in HD163296 folder or s255 folder



Image analytics

Moment map generator

 The moment generator can
produce a set of “moment”
images as defined in CASA

* (Generated moment images are
automatically appended.

« Moment images may serve as
a guide map for spectral
profile exploration

 May save a generated moment
image via “File -> Save image”

Fle View Widgets Help ® / OO D ~ =B N A B A DOFH K €% Q@ P 0O &G | S
HD163296_CO_2_1.fits
N F I : I ! 7:30.49); Image: (279, 53); Value: -2.62432e-3 Jy/beam ; Frequency (LSRK): 230.5336 GH I ! [ ]
R blarization: Stokes I B
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o
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o
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% 1 1 1 ! | 1 | I
22.5 17:56:22.0 21. 21.0 20.5
Right ascension
Render Configuration > Z Profile X
Image Active ~ Region Active ~ Statistic Mean ~ Polarization A M
8.00e-2 'l,| r_J'l
& 6.00e-2 rﬁ S
L 1
=
> 4.00e-2 -
B :
= 2.00e-2
s e T LL%‘
0.00e+0 —— — —— ——r ——— —
230.526 230.528 230.53 230.532 230.534 230.536 230.538 230.54 230.542

Data: (230.533563 GHz, 5.40e-2)

[LSRK] Frequency (GHz)

0.36

0.28

0.20

0.12

0.04

Region List X
Q"q.\ Name Type Center Size P.A. (deg)
. 17:56:21.055
Cursor Point -21:57:30.49 0.0
e g . . 17:56:21.2975158634 4.4000000000"
wh X A Region e -21:57:22.3412091901 4.5333333333" 4L
Animator X
K First M Prev > Play M Next A Last - Mode FrameRate & 5 :
© Channel e
0 18 m 54 75 230.5336 GHz
5.7696 km/s
0]
Image List X
Image Layers Matching Channel Polarization
0 HD163296_CO_2_1.fits R xv)(zJ(r] 38 Stokes |



Image analytics

PV map generator

 The PV map generator extracts a
slice from an image cube along a
line region (offset v.s. velocity

* The generated PV image is
automatically appended

 May save a PV image via “File ->
Save image”

» Spectral convention can be
changed with the image view
settings dialog

* Projection distortion is considered
when the offset axis is computed

File

View

Widgets

Hep ® /O O 0 ~

S255_CH3CN_subcube_pv.fits

Declination

24.00

[LSRK] Radio velocity (km/s)
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WCS: (=-0.3772322, 349.4252); Image: (3, 112); value:
g 6.23191e-2 Jy/beam*; Polarization: Stokes I
B
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0.2

0.3

0.4

Region Li{ py Generator @ % X

H

Generate PV image

Image (1: S255_CH3C... 1: S255_CH3CN_¢ &

Region (Region 2) Region 2 -
" ~
Average Width 3 <
Al Image View Settings
Global For spatial-spectral image
C Title Spectral axis
Ticks Coordinate = Frequency (GHz)
Grids
System LSRK $
Border
Axes
Numbers
Labels
Colorbar
Beam
Conversion
Image List X
Image Layers Matching Channel
0 HD163296_CO_2_1.fits R x¥)(Z]J(Rr] 38
1 S255_CH3CN_subcube.fits R XY Z R 0
HD163296_CO0O_2_1_pv.fits R C XY R 0
3 S255_CH3CN_subcube_pv.fits R XY R 0

O

Polarization

Stokes |
Stokes |
Stokes |
Stokes |

P.A. (deg)

0.0

<[>

1fits



Image analytics

PV map generator - interactive preview

A scalable version of
KARMA-kpvslice is
Implemented in v4-beta

A downsampled cube
can be created for PV
preview purpose

By dragging the PV cut,
the PV preview image is
rendered in the PV

preview widget

File  View Widgets

HD163296_CO_2_1.fits

Help
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Polarization:
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(169, 42); value: -1.16713e-2 Jy/beam ;
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Right Ascension
Render Configuration X
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X Profile: Cursor X
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- o
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=) X coordinate
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—| S| Y Profile: Cursor X
n o
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| 8 / \
- 3 / \
— o 5.00e-2
9 f
1 3 / N
_ = i — ot \ ~
- 000e+0 A NN AN T
— S
3 0 50 100 150 200 250 300 350 400
: Y coordinate
] Data: (WCS: -21:57:31.06, Image: 42 px, -1.16713e-2)
1 1 1 Image List Animator X Region List
20.5
K First M Prev » Play M Next A Last -> Mode Framerate < 5 :
© Channel -
X 0 62 88 124 186 249 230.5336 GHz
Custom Histogram Per-channel < IR ERkm/2
Clip min -0.035454988698 a
Clipmax 0.4336764885811
Scaling Linear <
E{ﬁWﬁMMﬂFﬁ
= Colormap [ . —

Invert colormap




Image analytics
Spectral line ID

File View  Widgets Help

* Spectral line IDs from the Splatalogue
(https://splatalogue.online/) can be over
plotted on a spectrum for line
identification

No image loaded

* |n this special use case, we need to
match the cubes in “frequency” via the
settings dialog of the image list widget
in order to compare images

* Use the line table to filter and select
target lines/species for ID overplotting

e Future enhancement

e Offline database

 Automatic line identification

=B &N &K EH O K S8 RQ P

& File Browser

C [ > users > kswang > Desktop > carta

_tutorial_v202302 > G31.41p0.31_bandscan

1.00e+0

Filename Type Size .= Date File Information Head
G31.41p0.31_spw25 fits FITS 17.3 MB 6 Feb 2023
G31.41p0.31_spw27.fits FITS 17.3 MB 6 Feb 2023

Q Filter ~

No file loaded

Load a file using the menu

Data type = float

[ 1 )
els
Number of polarizations = 1
Coordinate type = Right Ascen
xels [2
ords [1
(deg) [2
-0.16"
xxxxxxxxxxxxxx am
Celestial frame = ICRS
Spe SRK
Velocity definition = RADIO
Res 240
RA (
nece
Close

sion, Declination

Y Fuzzy search ~

Load selected Load as hypercube

No file loaded

Load a file using the menu



Image analytics
Rest frequency shifting

i
[
P
?
E)
=

File View Widgets Help e/ 00|~

S255_CH3CN_subcube.fits

 Frequency to velocity

Rl wcs: (6:12:53.9985, 17:59:23.07); Image: (64, 43); value: | 8

conve I’Si on d ep endS on the i;i;’,ii;f e eoiarie e R
RESTFRQ header

» The RESTFRQ header of
each loaded image can be
temporarily modified via the .
image list widget 10 enable a | e . I —
new conversion for line
matching ,_ L

e This applies to the spectral .~ . .~ -~ o~

[LSRK] Frequency (GHz)

axis of the PV image too

Data: (349.473354 GHz, 1.92e-1)

53.99

7

NAZUAU O 13)-T0(Z TS

}

1l

§
S
:

A M

349.48

0.18

0.14

0.10

0.06

S
=]

-0.02

Spectral Line Query X

Range $+ From 349.370 To 349.490 GHz ¢ Intensity Limit @) -5 m
Name Display = Description
1 Line selection () Column for line selection
2 Species () Descriptive formula of molecular species
3 Chemical Name O Common chemical name for species
4 Shifted Frequency o Shifted frequency according to the input velocit...

Velocity (km/s) < 4.5

ﬂ Species Chemical Name Shifted Frequency Rest Frequency R¢
CH3CN

1 CH3CNv8=1 Methyl Cyanide 349383.0511867788 349388.29560 0.137¢
2 CH3CNv=0 Methyl Cyanide 349388.0526117049 349393.29710 0.000
3 CH3CNv=0 Methyl Cyanide 349421.6047080713 349426.84970 0.000
4 CH3CNv=0 Methyl Cyanide 349441.7414058094 349446.98670 0.000
5 CH3CNv=0 Methyl Cyanide 349448.45450504246 349453.69990 0.000
6

Showing 5 filtered line(s) of total 391 line(s). Applied 1 filter(s). Selected 5 line(s).

Spectral Profiler = spectral-profiler-0 ~ m m m

Animator X

K First M Prev » Play M Next A Last - Mode FrameRate $ 5 _
|mage $255_CH3CN_subcube.fits
(0 | 1
© Channel e
0 62 124 186 250 349.4734 GHz
-329.2179 km/s
Image List X
Image Layers Matching Channel Polarization
0 S255_CH3CN_subcube.fits R xv)(zJ(r] 21 Stokes |
S$255_CH3CN_subcube.fits B sy R 2n Stokes |



Try to generate some moment images
« Use images in HD163296 folder or s255 folder

Try to generate a PV image

« Useimagesin HD163296 folder or s255 folder

Try to label spectral line IDs
 Use images in s255 folder (try CH3CN at ~4 km/s)

« Useimagesin G31.41p0.31 bandscan folder (try C2H50H “beer!” 1)
at ~98 km/s)

Try to match spectral lines in the velocity space by setting new rest
frequencies

 Use images in S255 folder and match
CH3CN J19-18 K=3 at 349393.2971 GHz
NH2CHO 16(2,14)-15(2,13) at 349479.5473 MHz

v 1 cosmos_field

cosmos_0_simbad.xml
© cosmos_herschel250micron_subimage.fits
© cosmos_spitzer3.6micron_subimage fits
O vla_20cm_lg_tan_10_subimage.fits

v ] G31.41p0.31_bandscan

© G31.41p0.31_spw25.fits

—

O G31.41p0.31_spw27.fits

v Gaussian_array

© Gaussian_SE fits

© Gaussian.fits

—

v T HD163296

HD163296_13C0O_2_1.fits
HD163296_C180_2_1.fits
HD163296_CO_2_1.fits
HD163296_CO0O_2_1.mom0O.fits
HD163296_CO0O_2_1.mom1.fits
HD163296_CO_3_2.fits

1o o} o} o} o} [0

" HL_Tau_pol

HL_tau_band3_Stokes_|.fits
HL_tau_band3_Stokes_Q.fits
HL_tau_band3_Stokes_U.fits
HL_Tau_band6_Stokes_IQUV.fits
HL_Tau_band6.POLA. fits
HL_Tau_band6.POLI.fits
HLTau_band7_cont.fits

o} [oF [oF o o} o o

v 1 IRCp10216_line_pol

O |RCp10216.cube.lQUV. fits

=

v i S255

© S255_CH3CN_subcube.fits

=



Polarization cube visualization and analysis

Stokes analysis widget and computed polarization components

@
3

e

&
I=
|
&
e

«“
k 4
%

File View Widgets Help e/ 100 ~ =

IRCp10216.cube.lQUV.fits

e When a Stokes cube is loaded,

q set of p|OtS IS gen erated in N O ..
the Stokes analysis widget j

e Q v.s. U profile and scatter
plot (Faraday rotation ;

Declination
42 43 44
[

1

* Pol. | and Pol. A profiles

13:16:40
[

9:47:57.4
Right ascension

57.8 57.7 57.6 57.5 57.3

e Use the animator to switch to
different Stokes (nhative) and
other (on-the-fly) computed
components

Z Profile X

Image Active ~ Region Active ~ Statistic Mean ~ Polarization Current ~

4.00e-2
3.50e-2
3.00e-2

2.50e-2
2.00e-2
1.50e-2

1.00e-2

5.00e-3
0.00e+0 A A A P AN A M N e

Value (Jy/beam)

W“MVMWV\WM L’W“‘L—"“me"w

3448 345 345.2
[LSRK] Frequency (GHz)

3442 344.4 344.6 345.4 345.6

Data: (345.377 GHz, 9.72e-3)

@ PV

HICIEAEIE:

Stokes Analysis : Region #1 (Active) X

5

~
v

7] I 0z I Uz Image  Active s Region Active < Frac.
1 £ 3.00e-2 D
] § 2.00e-2 3.00e-2
@© Kol
d4e =
S| = 1.00e-2
-1 Q
_ = 0.00e+0 2.00e-2
>
] -1.00e-2
- [}
L [ ]
— - a
] 4.00e-2 = 10082 R s
— o
1l | § 3002 S
- , 4] > ™
S| £ 200e-2 J = 0.00e+0 ’ = ®
_ 3 S
. g 1.00e-2 - | y 3
7] Lt 7 wwj =
0.00e+0 AWt (W dig i )
_ -1.00e-2
il @ 50 l ’Lwr
</ 8 \ | 1 I th -2.00e-2
- J .
| Bl T WM«M}M i
_ g -50
_ -3.00e-2
__ 344.5 345 345.5 -3.00e-2 -2.00e-2 -1.00e-2 0.00e+0 1.00e-2 2.00e-2 3.00e-2
- [LSRK] Frequency (GHz) Stokes Q (Jy/beam)
7 o | pata: (345.38 GHz, Q: 2.4le-3, U: 9.42e-3, PI: 9.72e-3, PA: 37.83)
— “ Animator X
1 K First M Prev » Play M Next A Last - Mode @ Frame Rate %
7] © Channel -
0 119 238 @ 357 479 345.3766 GHz
7 -327.2566 km/s
[0 | 479
m Polarization
AM Stokes | Stokes Q  StokesU  Stokes V Ptotal [ Plinear | PFtotal PFlinear Pangle
Image List X
Image Layers Matching Channel Polarization
0 IRCp10216.cube.IQUV.fits R xv]J(zJ(r) 329 Plinear
A

345.8



Polarization cube visualization and analysis

Vector field rendering

* A linear polarization field can be
computed and rendered from a
Stokes cube

* A linear polarization angle field can
be rendered from a pre-calculated
image

* An optional angle offset can be
applied (e.g., +90 deg to infer B-
field

* A scalar field can also be rendered

Matched images share their vector
field rendering

File  View Widgets Help

HL_tau_band3_Stokes_hypercube_IQU.fits

m|/|00 (2|~

WCS: (4:31:38.361, 18:13:57.23); Image: (1158,

9.21781e-5 Jy/beam*; Polarization: Plinear

58.0

1133);

vValue:

0.00015

un
~
ch =
$ 2
« =
£ =
O o
S e
o5
(s ]
©
wn
o
=}
o
2
W o
©w
wn
3850 38.48 3846 3844 38.42 4:31:38.40 38.38 38.36 38.34
Right ascension
™
0
n
g
o
g o
B =
o
o
~
wn
w0
"X
wn
(e
~
§% S
©
=
©
5]
(&)

56.8 18:13:57.0 57.2

56.6

56.4

38.48 38.46

38.44
Right ascension

3842 4:31:38.40

38.38

38.36

0.0003

Declination

576 578 580 58.2

56.8 18:13:57.057.2 574

56.6

56.4

38.48

38.46

38.44 38.42
Right ascension

4:31:38.40

38.38

38.36

80

60

40

Image List X

Image

0 HL_tau_band3_Stokes_hypercube_IQU.fits R

HL_Tau_band6.POLA fits
2 HL_Tau_band6.POLI fits

Animator X

K First M Prev » Play
© Image

0
Polarization
¢, Shg
o"es/ *@so

Render Configuration X
90% 95% 99% 99.5% | 99.9%

0.00005 0.0001

Value (Jy/beam)

Cursor: 1.60e-4 Jy/beam

0.00015

&) ¢
1

Layers Matching Channel Polarization
(xy](Rr] 0 Plinear
XY R 0
XY R 0
M Next A Last - Mode FrameRate $ 5 :
HL_tau_band3_Stokes_hypercu
be_IQU.fits
1 2
Sr ;Op. L.
O%e s, % /"’@a, e
0, 0, 0,
99.95% 99.99% 100% Custom Clip Min  6.1875271110545
Clip Max 0.000185720031%
Scaling Linear <
Colormap ]

Invert color map

0.0002 0.00025

Bias / Contrast ¥



Polarization cube visualization and analysis

Forming a Stokes hypercube

e If Stokes |, Q, U, and V are as I T e
individual files, you can use the file o
browser to form a Stokes hypercube i
and treat the result as a single (virtual)  Fil Browser o -
f | Ie C O > Users > kswang > Deskiop > carta_tutorial_v202302 > HL_Tau_pol
e Perform analysis with s . mmETEET

HL_Tau_bandé.POLIfts ~  FTS 11MB 19 Apr 2022
HL_Tau_band6_Stokes_IQUV.fits
HLTau_band7_cont.fits

e animator

Select a file from the folder.

* Stokes analysis widget

* Spectral profiler widget

Render Configuration X

* Vector field rendering dialog

No file loaded

No file loaded Load a file using the menu



Catalog visualization

Linked rendering

» Offline catalog (“File -> Import catalog”):

cosmos_spitzer3.6micron_subimage.fits

File View Widgets Help B/ 000~ =B N A HEH MO FHNK S8 L QP O HFO v 2 &

FITS and VOTable format
* Online catalog query
* The catalog widget supports filtering

» Catalog can be rendered and inter-linked

dsS

* Image overlay (GPU-accelerated,
WebGL2)

o 2D scatter plot
* histogram

 Matched images share their catalog

image overlay rendering el ieaanial

&
O | Catalog X o173 glul
No catalog file loaded
Load a catalog file using the menu
Image List X o7 B gllu
Image Layers Matching Channel Polarization
0 cosmos_spitzer3.6micron_subimage.fits R (xv])(Rr] 0
1 cosmos_herschel250micron_subimage fits XY R 0
2 vla_20cm_lg_tan_10_subimage.fits R XY R 0 RR



Catalog visualization

Marker-based catalog rendering

File View Widgets Help B/ 002~ B AKX B LD AL SR L QP B F O = | S ®
. I I I Iag e Ove rI ay aS ‘ O I l I I I I I I — cosmos_spitzer3.6micron_subimage.fits On@ o Catalog : cosmos_0_simbad.xml X Q2 O
. File 1 $ System ICRS % Size Color Orientation
m Mama : Limit : Thaman Nicnlas Descrlption
Catalog Settings: cosmos_0_simbad.xml O X
1| | Raw identifier as typed in the query
Lo}
o 2 File 1: cosmos_0_simbad.xml < Angular distance from the center
8 3 Main identifier for an object
S Shape 0 s
all Object type
[ | [ ] ) . ) )
. - 5 Size Color Orientation Right ascension
I I I I l 7 o —
3 i 10 -
?9 7 e o Coordinate error major axis
Thickness 2 : \_ID OTYPE_S RA
lo ( ler AGN Click to
n g o 1 Major  Minor E COSMOS ... AGN 150.117
[ ) O O r m a I n © 2 ECOSMOS.. AGN 150.121
3 COSMOS ... AGN 150.09¢
Column ANG_DIST 4 E
4 14] COSMO... AGN 150.13¢€
g 5 ) : . 14] COSMO... AGN 150.10€
® o Je||[ g|| Secaling Linear < ECOSMOS.. AGN 150.10¢
= 3 7 S ECOSMOS.. AGN 150.09:
3 8 Size Mode Diameter = Area 10002295+..  AGN 150.09!
. . . 9 ECOSMOS.. AGN 150.09¢
® rl e n a I O n m a I n 10 Clip Min 3.991e+1 ¥ of ECOSMOS.. AGN 150.132
o 1 12015 643706 AGN 150.13¢€
o
g - 12 . p E COSMOS ... AGN 150.071
- 13 Clip Max 4610e+2 5 off 12015 613159 AGN 150.06¢
14 E COSMOS ... AGN 150.06¢
o Showing 1 to 77 of 77 filtered entries. Total 20000 entries
S
= E Image Overlay $ RA RA_d s DEC DEC_d < MaxRows 20000 o
o
o Image List X @< O
Q
3 |« Image Layers Matching Channel Polarization
o
0 cosmos_spitzer3.6micron_subimage.fits R (xv])(Rr] 0
1 cosmos_herschel250micron_subimage fits R XY R 0
2 vla_20cm_lg_tan_10_subimage.fits R XY R 0 RR
o
S
w0
o

01:00 50 40 30 20 10 10:00:00
Right ascension



GUI customization

Custom layouts and preferences

e A custom |ayou't can be View Widgets Hep 8 0O DO~ ZEAXBUBEZLSE RGN [ 56O

. & Theme 3 Spectral Line Query >
3 Layouts »  Existing Layouts Default 1 ; Frequency (LSRK): 84.5157 GHz; Velocity: 114.5863 km/s; Range $# From 84.1 To 85 GHz $ Intensity Limit
kE\ /; 7) 57 Images »  Save Layout Cube View i ioti
® d V - L t - S | 't =] g Y/ Name Display  Description
save lew -> LayoutS -> oadve 1ayou . |
[Z] File header Delete Layout Cube Analysis Line selection Column for line selection
) Contours Continuum Analysis Species Descriptive formula of molecular species
(1 : . : Vector overlay . Chemical Name Common chemical name for species
: d (“View -> Layouts -> Exist ,,
FfreusSe Iew -> LaYOUTlS -> EXISTIN o . | - |
Lz Image Titting 4 Shifted Frequency Shifted frequency according to the input velocit...

79 2\ et
|ay0 UtS ) & Oniine Catalog Query /~ Preferences 0 x

Chemical Name Shifted Frequency Rest Frequency
Theme

® U Se t h e p refe re n Ce d i a I O g (“ F i I e = > ﬁef;d;f Configuration fethanol 84396.17598588455 84423.76900

Enable Code Snippets

3 . Contour Configuration Aethanol 84396.17598588455 84423.76900
Preferences”) to customize the GUI such as

Vector Overlay Configuration Auto-launch File Browser Aethanol 84493.54715074635 84521.17200

WCS and Image Overlay Aethanol 84493.54715074635 84521.17200

X X Aethanol 84716.3363106637 84744.03400
Catalog File List  Filter by file content <

. defau It Iayo ut Reagion tal 2536 line(s). Applied 1 filter(s). Selected 17 line(s).

e 9 Initial Layout  Default -

:ctral Profiler ~ spectral-profiler-0 ~ Filter Reset Plot Clear
Performance

Telemetry Initial Cursor Position Fixed @ Tracking

 default colormap for raster rendering

Initial Zoom Level @ Zoom to fit Zoom to 1.0x Play M Next A Last - Mode Frame Rate

Z Profile X

Zoomto ‘@ Cursor Current Center 479 1917:?:157 GHz

¢ regiOn CreatiOn mOdeS (Center—to—corner Or Image Active ~ Region Active ~ Statistic I L T
corner-to-corner)

§ 6.00e-1
* |Image pan modes (drag-to-pan or click-to- s =
pan) " 2008 0 G31.41p0.31_spw25 fits R (Z)(") 948 Stokes |

0.00e+0

84.5 84.6

¢ and many many more! PR

a: (B4.515684 GHz, 2.77e-1)




v 7 cosmos_field
cosmos_0_simbad.xml
© cosmos_herschel250micron_subimage.fits
© cosmos_spitzer3.6micron_subimage fits
© vla_20cm_lg_tan_10_subimage.fits
v 1 G31.41p0.31_bandscan

Load a Stokes cube and explore its context with the Stokes @ G31.41p0.31_spw25fits
analysis widget and the animator & 631.41p0.31_spw27fits

v 1 Gaussian_array

© Gaussian_SE fits

 Useimagesin IRCpl0216 line pol (Stokes analysis widget and

© Gaussian.fits

animator) v 7 HD163296
© HD163296_13C0O_2_1-fits
* Useimages in HL. Tau pol (animator) 8 HD163296_C180_2 1 fits

HD163296_CO_2_1.fits
HD163296_CO_2_1.mom0O.fits
HD163296_CO0O_2_1.mom1.fits
HD163296_CO0O_3_2.fits

v HL_Tau_pol

O HL_tau_band3_Stokes_|.fits
HL_tau_band3_Stokes_Q.fits
Load a catalog file, filter the catalog, and rendering it as an £ HL_tau_band3_Stokes_U-fits

catalog image overlay 8 HL_Tau_bandé_Stokes_IQUVits

Load a Stokes cube or a polarization angle image to render a —
polarization vector field

 Useimages in HL. Tau pol orimages in IRCpl0216 line pol

HL_Tau_band6.POLA. fits
HL_Tau_band6.POLI.fits
HLTau_band7_cont.fits
v 1 IRCp10216_line_pol
Explore the preferences dialog 8 IRCP10216.cube.IQUV fits
v B S255
© S255_CH3CN_subcube.fits

* Use images and the catalog in cosmos field folder



Thank you~

We hope CARTA can make your life easier &

Please contact support@carta.freshdesk.com for any questions/comments

HOME = FEATURES GALLERY

Cube Analysis and Rendering Tool for Astronomy, isa %
next-generation image visualization and analysis toof
designed for ALMA, VLA, and SKA pathfindets. « _

Installation m Helpdesk !: :
"L v

https://cartavis.or o e ey,

DOI 10.5281/zenodo.3377984

Cite CARTA!
This project needs your support!
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